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Introduction

udioworxs is an advanced digital dictation and voice document management system.

With Audioworxs, users can dictate and receive digital voice data from any location via telephone,
professional dictate station, PC, or portable dictation device. Audioworxs Player gives
transcriptionists, editors and authors real-time access to jobs on an Audioworxs system.

Feature Overview

e Real-time database access

e Secarch capabilities

e Footpedal support

e Configurable rewind and fast forward amounts

e Select, return, suspend, and complete a job

e Start playing before audio completely downloaded
e Multiple screen modes (full, mini, system tray icon)
e Volume control and pitch-corrected speed control
e LAN, WAN, and Internet compatible

e Batch download audio files

e Ability to change job demographics

e Configurable column ordering

e Audio tag markers (i.e. bookmarks)

e Generate a Personal Productivity Report
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AUDIOWORXS™ AUDIO MANAGEMENT SYSTEM CI I

CHAPTER 1

Player Overview

Audioworxs Player is the primary tool used by a transcriptionist or editor. It provides live, real-
time integrated access to job information contained within an Audioworxs system.

The very first screen that you will see when Audioworxs Player starts is the "Login Window". The
Login Window provides security against unauthorized access to protected information. At this
Window you are required to select the appropriate login script and enter a valid user ID and
password.

i Audioworxs Player Login

o |

The very first time you see the Login screen you may need to setup a login script for the system
being accessed. Press the Setup button to access the Connection/Login setup window.
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Connection/Login Setup il

{* Script 0 " Seript 1 £ Seript 2 £ Seript 3 Apply |

—Job Sepver
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ITran&crlptlon
Port: |1 FX;

— File Transfer Server

Station 1D

Ii&mitH

|P:| 127 .0 .0 . 1

Syztem Mumber:
. 1702
por | 0001
—Login az...
Llzer: IDD‘I 1234

% Transcriptionist ¢ E ditor 1 " Editor 2 Author Review

— Connection Speed [File Transfer Buffer Size]

¢ Cable/DSL/LAN [32KB) Communications Timeaut; IEU— ill
150N [16 KE)
" Modem [2 KE]

= Custom buffer size I bytes Ok, I Cancel |

Enter the information as provided by your system administrator and select the appropriate
connection speed. More details are provided later in this guide under the heading
Connection/Login Setup.

Audioworxs Player - In Detail

Audioworxs Player is designed to display on your screen in your choice of three different modes —
Main Console, Mini Window, and System Tray Icon.
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Main Window

(Tran) 001-1234
File Wiew Options Help
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All functions are accessible by mouse click or keystroke. Each row in the job list displays
information about a job on the Audioworxs system. Only jobs meeting the routing specifications
for your login ID and role are displayed. The total number of jobs currently in the list is identified
in the field labeled “Total Jobs” where the total count and the total length (expressed in
hh:mm:ss) is displayed.

Column order can be changed by clicking on a column heading and dragging the column to the
right or left while holding the mouse button down. Release the mouse button when the desired
position is reached. Column location and column width changes you make are “remembered” and
will be re-established the next time you run Player.

COLUMNS
Priority Color Code

A column of colored “balls” provides a means of quickly identifying the relative priority of the
jobs in the list. A green ball indicates a job that has a priority between 0 and 35. A yellow ball
indicates a job has a priority between 36 and 74. The highest priority jobs, those having a priority
over 75, are identified with red balls. (Note: In versions of Audioworxs Player before 2.00.016 the
ball color was associated with the Job’s status.)
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Red: Priority = 75+ \> | &udio | Job Mumber

v 001-22-000195

¥ 001-01-000504

b 001-01-000857
007-07-001054

#  001-01-0003945

Yellow: Priority = 36-74

v

o0 C o

Green: Priority = 0-35 \>

To remind you that there is one or more priority jobs in the job list even if they aren’t visible (for
example, when a column other than priority is selected for sorting) a large red LED will flash. The
LED, located between Download Progress and Activity Tracker, is off (gray) when there are no
priority jobs in the current list.

Download Progress Activity Tracker
001-01-D00325(0) wav @ Job 007-01-000325 zelected.

Audio

When a job is selected a temporary copy of the audio file is made on the local computet’s hard
drive. If the audio has not been downloaded the Download status will display a grey progress
meter. If the audio is already on the local drive the status will display “Downloaded” and if the
job does not have an associated audio file the status will display “No Audio”.

Job Number

Every job in an Audioworxs system is uniquely identified with a Job Number that has the format

Status

Either a word descriptor or a number represents the status of the job. Depending on what role
you are logged in as you may see one or more of the following statuses:

Transcriptionist

Transcription The job is part of the general transcription pool and may be available to
others.

Tran Active Job has been made active by the current login ID. A job identified as Active

is not necessarily the current active job. A single ID can have more than one
job active in the system at one time but only one job can be the current
active job in Player.

Tran Suspended The job is suspended - no other ID can access this job. Suspended jobs may
automatically be returned to the general pool after a time period specified in
the login ID’s transcription profile.

Tran Assigned The job has been assigned to the specific login ID and no other user will
have access to this job.
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Editor 1

Tran Query A job with this status has been completed by a transcriptionist after having
added one or more query tags to the job. This job may be available to other
editors.

1" Edit The job is part of the general first stage edit pool and may be available to
others.

Edit 1 Assigned The job has been assigned to the specific login ID and no other user will
have access to this job.

Edit 1 Active Job has been made active by the current login ID. A job identified as Active
is not necessarily the current active job. A single ID can have more than one
job active in the system at one time but only one job can be the current
active job in Player.

Edit 1 Suspended | The job is suspended - no other ID can access this job. Suspended jobs may
automatically be returned to the general pool after a time period specified in
the login ID’s transcription profile.

Editor 2

2™ Edit The job is part of the general first stage edit pool and may be available to
others.

Edit 2 Assigned The job has been assigned to the specific login ID and no other user will
have access to this job.

Edit 2 Active Job has been made active by the current login ID. A job identified as Active
is not necessarily the current active job. A single ID can have more than one
job active in the system at one time but only one job can be the current
active job in Player.

Edit 2 Suspended | The job is suspended - no other ID can access this job. Suspended jobs may
automatically be returned to the general pool after a time period specified in
the login ID’s transcription profile.

Author Review

Review Req’d The job has been made available to an author for digital signing.
Complete The job has been fully processed.
Priority

The priority of a job describes its relative importance as compared with other jobs in the system.
A priority can be any number from 0 (lowest) to 100 (highest). Certain priorities have special
meaning. 0 means that a job has been blocked from further processing. When logged in as a
transcriptionist or editor blocked jobs are not displayed. Other pre-defined priority values are
replaced with a descriptive word: 25(Normal), 50 (High), 75 (Stat) and 100 (Critical).

Audio Length
This column describes the length of the job’s associated audio file. The length is expressed in the

format HH:MM.:SS by default. Optionally, the format can be expressed as MMM:SS by changing
the appropriate setting in Options=>Setup=> Preferences=>Screen Controls.
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Save Date

This is the date and time that the author saved the job. Or, in the case of jobs created by an
automated import utility, it is the date that the job was imported.

Audio Create Date

This is the date that the associated audio file was last modified while being created by an author.
In the case of job’s created using Audioworxs’ telephone interface (Call Manager) the Save Date
and Audio Create Date will be the same. When a job is imported into the system the Audio Create
Date will generally be before the Save Date.

Input Fields

Ten input field columns exist, one for each of the possible input fields available on an
Audioworxs system. The input field labels that are displayed as the heading for each of the
columns is configurable and is based on your login ID’s group number (the first 3 numbers of
your User Number). The first time you run Audioworxs Player the input field labels are
downloaded to your local computer for quick access. To re-download the labels from the
Audioworxs system select the “Refresh Input Field Labels” button in the setup dialog’s
Preferences tab.

Playback Controls

When a file is selected for preview or is selected (i.e. made active) the playback
controls become active. The file length is displayed and the current playback position
is displayed as both an absolute number and a relative position on a sliding position
bar. A job number will only be displayed beside the label “Active Job” when a job has
been selected and is made active. No job will be displayed as Active when just
previewing the associated audio.

File Length: [NHNESN Time Played: INANBEN Active Job: 001-01-000005

A
T T T T

Arrows below the position slider indicate the location of tags (bookmarks) within the
audio. Blue arrows represent general tags, red arrows represent query tags, and green
arrows are tags added automatically when a job is suspended.

Speed Control
@_@ Press the blue down arrow to slow down playback speed,
press the red arrow to increase playback speed.

Volume Control
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EI L Press the blue down arrow to decrease volume, press the
red arrow to increase volume. The initial volume when the Player is started is based on
the “Wave Balance” setting in the Windows Volume Control window.

It may be necessary to make additional adjustments to your system to allow greater ranges of
audio volume and tone control. To access Window’s volume control select Start on your
Windows desktop. Then select Programs=> Accessories= Entertainment=> Volume Control.

The standard Window’s Audio Control sliders are illustrated below:

[E Master Volume == B3

Options Help

Master Volume | Wave SW Synth CD Player PC Speaker

Balance: Balance: Balance: Balance: Balance:
B-f 8 Bk 9 - fd

1 LR O § { AL !
Yolume: Yolume: WYolume: Wolume: Yolume:
™ Mute all [~ Mute [ Mute ™ Mute ™ Mute

IClystaI SoundFusion{tm)

Adjust these controls to tailor playback to your requirements. Drag the Volume slider
up to increase the volume, or down to decrease the volume.

Other Controls

The table below describes other playback controls on the main window.

@ Rewind @ Stop
Rewind into the current dictation. = Stop previous action agd return to
beginning of current dictation.
“ | Pause Playback of the current dictation. e Play the current dictation,
I ; Fast Forward Speed Reset
h = |Forward into the current dictation. - Resets the speed to normal.
I Server Connection Status Footpedal
J5- . A green “light” indicates that a connection to the When checked footpedal support is
_ Audioworxs Job Server (JS) and File Transfer I enabled. To temporarily turn off
Fe- Server (FS) is good. When the connection has FF footpedal support click on the check
’ been lost the “light” will be red. A number inside box or the letters “FP” to remove
the green or red circle indicates the number of the check mark. The check box will
times the connection was lost and then re- be grayed out when footpedal

Document # 1.00.003.20110823 7 ©2004-2011 Dataworxs Systems Limited




AUDIOWORXS™ AUDIO MANAGEMENT SYSTEM

established. support is not enabled or there was a
problem enabling the footpedal.

Tool Bar Icons

EREREERELME SR icmN D

Tool bar icons provide quick access to frequently used features. In the table below each tool bar icon in
Audioworxs Player is described. The keyboard shortcut shown between the angle braces (<>) can be
used in place of clicking the icon with a mouse.
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3

Select Job <F6>

Selects a job by changing the status to “Active”
and downloading the audio to the local drive.

Return Job <F7>

Returns the currently selected job back to the
“Transcription” status (or Edit if logged in as an
editor) to make it available for other
transcriptionists (or editors).

=

Suspend Job <F8>

Suspends or reserves the currently selected job
so that you can continue it at a later time. No
one else will be able to select this job.

Complete Job <F9>

Completes the currently selected job. If a query
tag has been added while logged in as a
transcriptionist, the job will be set to the “Query
Pending” status, otherwise it will be set to the
status defined in your transcriptionist profile.

Display Player Version Information <F2>
Displays the Player’s “About” window
containing application version information.

Search <Alt+H>

Brings up a search dialog. This feature is only
available if your Transcriptionist Profile allows
it.

Download/Self-Assign Selected Job(s)

Begins downloading audio associated with the
selected jobs. If the option to Self-Assign is
enabled, the status of the jobs is changed to
Suspended to prevent others from selecting
the jobs.

s 2| & |

Stop Download

Aborts any audio download currently in
progress.

Tool Bar Legend
Displays a legend showing each tool bar icon
and its function.

gsx
e

Setup <Alt+S>
Launches the setup dialog.

Mini Window <Alt+M>
Changes the display mode to the Mini window.

Send to System Tray

Minimizes the application to the Windows
System Tray.

Open Tag Window <Alt+B>
Launches the tag window for viewing,
editing and use of existing index tags.

Add Query Tag <Alt+Q>

Adds a query tag at the current play position.
If logged in as a transcriptionist, when one or
more query tags are added, the current job
will be saved as “Tran Query” regardless of
the Complete Status defined in the
Transcriptionist Profile.

Add General Tag
Adds a general tag at the current play position.

Document # 1.00.003.20110823 9
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Mini Window

Audioworxs Player

Length: -F'Iayed [GERE] Job#: 001-01-000325 3¢

In Mini Window mode the most commonly used functions are accessible by a mouse click. By
default, when you select the Mini Window it will be stationed in the upper left-hand corner of
your screen but can be moved to where it is least obstructive. Once moved, its position will be
remembered and returned to that position the next time you initiate the mini window. This mode
is useful when typing with a full screen word processor program. You will still be able to see the
player display, but remains out of the way while typing.

A large LED on the far right of the mini window will flash red as a reminder that there are one or
more priority jobs in you current job list. If there are no priority jobs in your list then it will be off

(i.e. gray).
System Tray Icon

_ O\
PE DR @11:42%1

In this mode no window is displayed but you are able to continue playback of the selected job
using your footpedal. The Player window can be made visible by double clicking the Player icon in
the System Tray (bottom right next to your time display).
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CHAPTER 2

Working with Jobs

Transcriptionist/Editor

Once you have logged into Player as a transcriptionist or editor the main job list will display one
ot more jobs that are available to you. The number of jobs you see is partially determined by how
many jobs are available in the Audioworxs system and partially by restrictions defined in your
Transcriptionist Profile. The Transcriptionist Profile assigned to you tells the Player what features
are available to you and tells Player how many Jobs you are able to see in your job list at any one
time. The Transcriptionist Profile is setup and maintained by the Audioworxs system
administrator.

Searching for a Job: The jobs you see in your job list are partially determined by the settings in
your Transcriptionist Profile. However, it is also affected by the search criteria you have defined
(if your Profile allows you to use this feature). To change the search criteria press Alt-H, press the
“Job Search” toolbar icon, or choose the menu option File=>Search.

IMPORTANT! If you select anything other than the option “Search all records” in the Job
Search dialog you must remember to make sure the search criteria is what you want each time you
finish a job. If you forget, the jobs you see in your job list may not accurately reflect what is
available to you for transcription or editing.

Sorting a column and scrolling down the list can also be used as a search technique. To sort a
column, click the column heading.

Selecting a Job: To begin a Job you must first “Select” the job by highlighting it and then
pressing F6, pressing the Select Job toolbar button, or double clicking on the job. Once selected
the status will change to indicate that you have been assigned the job and the audio will begin to
download to your computer. The “Download Progress” section will display the progress of audio
transfer. You can begin playing the audio while it is still downloading after only a few seconds of
downloading time (depending on your connection speed).

001-22-000195(0).wav L

" Download Progreszs
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[ T fudio | Job Mumber The Audio column in the job list identifies whether or not audio is
¢ 01-22-000195 | available for the job and if the audio has already been downloaded to

we [O01-07-D00504 your local computer. A Y’ indicates that the associated audio already
00 -01 -000es7 exists on your local computer. An ‘N’ means that audio is available
001 -01-001 054 for the job but has not yet been downloaded to your local computer.
001-01-000345 An X’ means that audio is not available for that specific job.
00m-01-0mma

000CC

HoHEZE

The downloaded audio is temporary and will be deleted when you complete or return the job or
when the Player is closed.

If you select a job that has been already selected by someone else a message will tell you that the
job is not available and the job list will automatically refresh. You should manually refresh the job
list before selecting a job if you have left the Player idle for a period of time. In the time since the
job list was refreshed the status of the jobs you see may have already been changed. To manually
refresh the job list press F5.

Once you have finished the transcription of a job you must Complete, Suspend, or Return the
Job.

Completing a Job: To complete the job press F9 or press the Complete Job toolbar button. If
you have not listened to the end of the audio (or fast forwarded to the end) you will be asked to
confirm that you really want to complete the job.

attention X

The audio associated with <001-01-001021 > has not been plaved ta the end.
Are wou sure you want ko complete this job?

If you have the option to “Upload transcribed documents on completed job” enabled you will be
asked to browse to the text document that you want to associate with the Job just transcribed.
You can upload one or more documents to associate with the job just selected. To upload a
transcript, choose Transcript before pressing the Choose a document to send button. When an
author has dictated more than one report in one dictation file you can identify each transcript with
a different report number. Choosing document type Attachment can be used to upload a
different type of document, an image file or special note for example. Press Done when you have
finished uploading associated documents. If you press Cancel you are telling the Player to cancel
the Complete command. The active job will not be completed. However, if documents have
already been transferred they will remain associated with the job.
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Upload Associated Document x|

& job iz being completed. To zend and aszociate a document with thiz
job prezz "Chooze a document to send"’. Presz "Done’’ when

youl have no more documents agsociated with thiz job to zend.

I 007-01-000002

Chooze a document to zend... Daone | Cancel |

¥ Tranzcript [twped documet]

Feport Mbr: |'| _Ij

" Attachment [graphics, images, bitmaps, ete. |

Documents Uploaded: IEI

Lazt Document: I

Once all associated documents have been sent to the Audioworxs system, the job list will
automatically be refreshed and Player will wait for you to select a new job.

Suspending a Job: To change the status of the active job to “Suspended” you simply press F8
or press the “Suspend Job” toolbar icon. The job’s status will be changed to suspended and a
suspend marker will be added to the job. Later, when you re-select this job you can open the
Marker dialog and go directly to the point in the audio where you left off. If you do not re-select a
suspended job after a certain period of time (defined by the Audioworxs system administrator) the
Audioworxs system will automatically return the job to the pool of jobs available to others.

Returning a Job: If for some reason you are unable to transcribe or edit a job that you have
selected, and want to return it to the pool of jobs available to others, press F7 or press the
“Return Job” toolbar icon. The job list will automatically refresh. The job that you just returned
will not show up in your job list for a configurable period of time (defined in your
Transcriptionist Profile).

Changing a Job (as a transcriptionist/editor): While a job is active, and your
Transcriptionist Profile allows it, you can change the Author and/or any of the 10 input fields
associated with the job. To make a change to the job choose the menu option File=>Change
Demographics.

Changing a Job (as an administrator): While logged into Player as an “Admin” you have the
capability to change many more demographics and parameters related to a job. To make a change
to the job choose the menu option File=>Change Job or press the “Change Job” toolbar icon.

E
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AUDIOWORXS™ AUDIO MANAGEMENT SYSTEM

Alternatively, if you want to change the priority or status a “Quick Change” option is available
from the right—click menu. Highlight the job(s) to be changed and press the right mouse button.

0071-01-0001 o

Tran Sighed Out Marmal (28] 054000, Te

0071 -01-0r
0o -0 -0
001 -01-0r
001 -01-0r
001 -01-0r
001 -01-0r
001 -01-0r

Job Details,
Change Ju:ul:u Alk+D

Cuick, l._|'|-:|r||;||:e lab... CErl+Alt+D
Event Log...

Manage Users and Profiles

Search...

Signout Jobs. ..

=t

=t

When you choose “Quick Change Job” a dialog is displayed allowing the status and priority to be
changed along with the ability to add a note to the job.

Quick Change

Apply the following changes to all zelected jobs:

Status: | Tranzcription

Pricrity: |T"'E

=

< |Blacked (0] R

Mote: |F'ri|:-rit_l,l increased - request by Dr. S mit

] | Cancel |

Advanced Configuration Note: A default status and a default priority are configurable.
Depending on the application of this feature, this feature can be configured to allow the user to
simply type a note and then press <Enter> to apply the change. Check with your Audioworxs
dealer for additional details on configuring this feature.
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AUDIOWORXS™ AUDIO MANAGEMENT SYSTEM
Author Review

Once you have logged into Player as an author for author review the main job list will display one
or more jobs that you are able to preview. The number of jobs you see is partially determined by
how many jobs are available in the Audioworxs system and partially by restrictions defined in the
routing profile assigned to your Author Profile. Your Author and Routing profiles are setup and
maintained by the Audioworxs system administrator. In general, as an author you are able to
review all jobs authored by you once the job has been saved even if it has not been completely
transcribed and/or edited.

When you first login to Player for Author Review you are automatically shown jobs that you have
authored. Unless your routing profile (specifically the Author ID route field) restricts access to
dictations by other authors, you can view jobs from another author by accessing the Job Search
dialog and choosing a specific author from the Author drop down list. To again view your own
jobs, clear the Author field in the Job Search dialog.

Searching for a Job: The jobs you see in your job list are partially determined by the settings in
your Author Profile. However, it is also affected by the search criteria you have defined. To
change the search criteria press Alt-H, press the “Job Search” toolbar icon, or choose the menu
option File=>Search.

IMPORTANT! If you select anything other than the option “Search all records” in the Job
Search dialog you must remember to make sure the search criteria is what you want each time you
finish a job. If you forget, the jobs you see in your job list may not accurately reflect what is
available to you for review.

Sorting a column and scrolling down the list can also be used as a search technique. To sort based
on a specific column click the column heading.

You can further restrict your job list to only jobs assigned the status “Review Required” by
enabling the option ‘Show “Review Required” jobs only’ in the setup dialog’s Preferences tab.

Previewing a Job: To listen to a job you simply need to select the job and press the Play button.
To play and download an associated document, press the “Select” button. If more than one
document is associated with the job a dialog window will allow you to select which associated
document to download. The selection defaults to the last transcript document associated with the
job. Usually you can simply press OK (or press <Enter>) when you are presented with the Select
Document window.
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AUDIOWORXS™ AUDIO MANAGEMENT SYSTEM

select Document x|

blore than one aszociated document was found for job ses-ss-sms
Select a document and prezs OF. to download the document.

Presz Cancel to continue without downloading an azzociated document.

I[Transcript] Tranzcnpt [3).tat [10345 bytes] j

ak. I Cancel |

Making a Job Active: When a job has the status of “Review Req’d” selecting a job also makes
the job active. Once active you are able to electronically sign the job or return the job. An job is
active when it the job number is displayed beside the label “Active Job” in the playback control
area.

Adding a Note: While a job is active you can add a short note to the job by pressing the “Add
Note” toolbar button. A note is a short text message that is linked to the current playback
position. View notes ot other bookmarks by opening the tag/bookmark window.

Returning a Job: After reviewing a job that is active it can be returned to the editor or
transcriptionist pool by selecting the “Return Job” toolbar icon (or pressing F7). After selecting to
return a job you are prompted to enter a short text message to identify why the job is being
returned.

Signing a Job: After reviewing a job that is active it can be digitally sighed and marked complete
by pressing the Sign Job toolbar button (or pressing F9). A digital signature is added to the
associated transcript document. The digital signature ensures that the document cannot be
modified without it no longer matching the signature.

Generating Reports

As an Admin

When logged into Player as an Administrator, you can quickly access Audioworxs Reporter to generate
various report types without having to run Reporter directly. To do so, right click a job in the Job list
and choose the type of report from the available options: Author Report, Transcriptionist Report,
Editor 1 Report, Editor 2 Report, and Backlog Report. If you choose the Author, Transcriptionist or
one of the Editor reports the corresponding user number from the highlighted job is used to generate
the report.
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AUDIOWORXS™ AUDIO MANAGEMENT SYSTEM

Once a report type is selected from the right-click menu reports are actually generated by Audioworxs
Reporter (see the document Awudioworxs Adpministrator Guide for detailed information about Reporter).
Since Reporter is completely configurable you will need to ensure that the correct report number is
mapped to the different report types. See the section Interface Options in Chapter 3 for additional

information.

Job Details. ..

Change Job...

Event Log...

Manage sers and Profiles
Search...

Signouk Jobs. .

Ale+D

Download Audio
Download Docurment
Associabe Document

Alt+4
Alt+G

Author Repaort

Transcripkionist Repark
Editor 1 Repork

Editar 2 Repark

Backlog Report Chrl+1
Fun Reporker

Refresh F5

As a Transcriptionist/Editor

When logged into Player as a transcriptionist/editor, you can generate a report that shows your
personal productivity for a specified date range. With any job highlighted in the job list right click
to bring up the right-click menu. Choose “Pers. Prod. Report” to generate your own personal
productivity report.

You will be prompted to select a date range. The report will contain jobs that you completed

000 CCCCC oL

001-01-000039 | Transorp|  S5ieet Jab

001-01-000004  Transcrip  Foecdrm Job F7
001-01-000113  Transerip  —sPend Job F&
001-01-000114  Transcrip  -omplete Job Fo
00101000093  Transcip  —Nangs.. Alt+D
007-01-000105 | Transcif  Download Audio Alb+a
001-01-000106  Transcif pownload Document Alb+G
007-01-000108  Transcrip

001-01-000003  Transcri I e el AT
001-01-000015 | Trahscle pafrash F5
001-01-000094  Transcrpmom—zs —

within the specified date range.

oM = @ m o= W

WWW
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Select Date Range

Start Date: 20070515  w| o0 =
EndDate: (20070515 wf[2565 =
0K I Cancel

AUDIO MANAGEMENT SYSTEM

f* Day
i wieek
" Maonth

The report generated will look similar to the following example:

Audioworxs Audio Management System
Personal Productivity Report

Transcriptionisi Save Date: 2007-05-15 00:00 to 2007-05-15 23:59
Transcriptionisi: 001-1234

Status Range: <Tran Query> to < Complete>
Reporxt Type: Detailed

Job Nbr.

001-01-000027
001-01-000052
001-01-0000641
001-01-0000642
001-01-0000643

Author

01-1234
01-1234
001-1234
001-1234
001-1234

IF O

o0
11

Create Date

2005-07-13 20:02
2006-11-08 19:44
2006-11-16 14:08
2006-11-16 14:11
2006-11-16 14:03

Save Date

2006-05-26 13:43
2006-11-0% 16:03
2006-12-04 10:10
2006-12-04 10:10
2006-12-04 10:10

Len (m;s)

1:34
0:13
0:14
0:07
0:38

Tran Start Date

2007-05-1513.03
2007-05-1508:11
2007-05-1508:51
2007-05-1509:52
2007-05-1508:51

Tran Stop Date

2007-05-1513.05
2007-032-1508:13
2007-05-15 0953
2007-05-15 0959
2007-05-150%9:54

Total Jobs: 29

Personal Summary
Total Jobs: 5 (1683 % of group total)
Total Length (min:secs): 7:21 (11.24 % of group total)

Avverage Length (minsecs): 0:33

Group Summary

Total Length (min;secs): 65:25
Average Length (min;secs) 2:15

Configuration Note

In order to run a Personal Productivity Report, a transcriptionist/editor must have an Admin Profile
specified in their User Profile. They do NOT need to have the role of admin assigned.

Document # 1.00.003.20110823

18

©2004-2011 Dataworxs Systems Limited




AUDIOWORXS™ AUDIO MANAGEMENT SYSTEM

CHAPTER 3

Setup and Configuration

To get the most of Player you will need to setup a few things. The three main items that may need
to be setup are:

1. Audio CODECs
2. TFootpedal Support
3. Temporary Folders

Audio CODECs: An audio CODEC is a driver installed into Windows that allows a specific
audio format to be played. Windows already has a number of standard CODEC:s installed but not
necessarily the CODEC you will need to play all the audio formats sent to you for transcription or
editing.

During the installation of Player three CODEC setups are installed into the install_dir\Dataworxs

Systems\ Utilities folder for yout convenience. You may need to install one or more of these
CODEC:s.

1. Rhetorex ADPCM (Rhet_Setup.exe): To install this CODEC use the shortcut
Start=> Programs—>Dataworxs Systems—> Utilities> Rhetorex CODEC Setup.

2. Norcom ADPCM (SetupCC.exe): To install this CODEC use the shortcut
Start=> Programs—>Dataworxs Systems=> Utilities> Norcom CODEC Setup.

3. Sanyo LD-ADPCM: To install this CODEC use Windows Explorer to browse to the
install_dir\Dataworxs Systems\Utilities folder, right click on the file LDADP32.inf and
choose “Install” from the menu.
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Temporary Folders and Footpedal Support: Temporary folders and other setup items
(including footpedal support) are configured from the setup dialog. The Setup dialog is launched
by clicking on the setup icon located on the tool bar or selecting the menu item Options = Setup.

#

KA S G R M L

<

256 @E

The Setup Options dialog is divided into functional groups each accessible by clicking on one of
the tabs.

Folders Tab

X

Setup Options

Preferences Folders l Interface Options ] Connection/Lagin Setup ] Third Party Interface SEtup]

Local fudio Folder: |E:’\F'mglam FilezD atawores Spstemz'AudiomwanziClientaudiot
[where downloaded audio iz temporarnily stored on o local drive. ]

Caution! Do not set the Local Awdio Folder to a folder used
by any other program. Player will delete files from this folder.

Inter Proceszs Contral Folder: |E:'~.F‘mgram FileshD ataworss Spstems dodiomansz s Chents PCY Browse...

[If enabled, thiz iz where the azzighment notification file iz written to.)

i

Document Template Folder: |E:’\F'mglam FileshD ataworss Spstemshdudiowonss\Clients Templatesh Browse...

[Cocument templates aszociated with a zelected job are downloaded to this folder. ]

Mon-udio Download Folder: |C:\F‘rogram FileshD ataworss Spstems\dudioworsz\Client\Downloads' Browse...

il

Local Tranzonipt Folder: |C:'\F'rogram Fileg'[ ataworde Spztemz'AudiomwonziDocumentzh Tranzoripts Browse...

[This iz where tranzcripts are saved on this local computer once created or edited.)

Chent Maoritor Job Repart: |E:’\F'mglam FilezD atawor<s Spstemz‘AudiowanziLogDva obBeport. bl

[Requires the uze of Audiowarxs Client Maonitor with the Job Report option enabled.]

|pdates;
[v Check for updates when Plaper started
Update Manager: |c:\Prngram Fileg\D ataworss SpetemazUtilities\Dwl pdatetgr.exe Browse...
Update tanager Launch St |"c::'~.F'mgram Files\D ataworsz SystemzidudioworssiProgramiaudioworss Pla

(] | Cancel |
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Local Audio Folder is the location to which audio and associated documents are temporarily
downloaded from the main server for local transcription. The audio is automatically erased from
this directory when the job is completed or returned.

Caution! Do not set the local audio folder to a folder that is used by any other program —
including Audioworxs System Manager. All files in the specified folder may be deleted by Player
without warning.

Inter Process Control Folder is the location for the exchange of information between the player
and an integrated typing application. Interface files selected in the Interface Options tab are
created in this folder.

Document Template Folder is the location on your computer where document templates
associated with a job that you have selected are downloaded.

Local Transcript Folder is the default location where Player will look when you have selected to
upload an associated transcript when you complete a job. You will be given the opportunity to
browse to any folder regardless of what default you specify here.

Client Monitor Job Report specifies the location on your computer where the Audioworxs
Client Monitor is writing the job report. When the Audioworxs Client Monitor is running with the
Job Report option enabled you can choose the Client Monitor Report option from the right-click
menu on the Job List to view the report. When the Client Monitor Report option is selected from
the right-click menu the last report created will be displayed in your computer’s default browser.

Updates group is used to configure Audioworxs Player to check for and automatically download
updates. Updates are defined by the Audioworxs dictation system administrator and may include
application updates and setting changes.

Document # 1.00.003.20110823 21 ©2004-2011 Dataworxs Systems Limited




Preferences

Setup Options N x|

Preferences | Folders | interface Options | Connection/Login Setup | Third Party Interface Setup |

— Playback Controls r— Screen Controls

[~ Show Search Dialog on startup {Admin only)

Auto backspace (s): IZ_ j [V Enable Job Bar
FFwd Time (s): |'10_ _:—_l] Show a maximum of I 2000  jobsinthe job list.
Rew Time () |5 :]J Manage Input Fields... | More... |
More... '
Footpedal Selectiol Rttt
— 1 n
[V Footpedal attached [V Upload transcribed document on completed job
 VEC V' Use document templates ftranscriptionist only)
o [V Find associated documents

™ Enable auto launch of associated documents
" Olympus RS23/RS24  Configure...
% —I ™ Local copy {do not use File Transfer Serverto retrieve files)

" Oympus RS27/RS28 [~ Always use existing audio
" Philips 6212/230c [ switch pedals I” Seff-assign job when audio downloaded

% Virtual Footpedal ll [” Enable preview mode transcriptionist only)
o Feviow [V Enable background batch downloads
¥ Show "Review Required" jobs only e l

The Preferences tab allows for the configuration of the footpedal, refresh rates, and other file
control settings.

Playback Controls

Swap footpedals allow you to reverse the right and left functions on the footpedal.

In the default
configuration this is
Reverse. When Swap
footpedal is selected this
is now Fast Forward.

In the default configuration

this is Fast Forward. When

Swap footpedal is selected
this is now Reverse.
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Auto Backspace provides an automatic backspacing feature to help you keep your place while
transcribing a job with the footpedal. The backup amount can be adjusted from 0 to a maximum
of 5 seconds in quarter second increments. For example, if the automatic backspace is set to 4,
each time you stop the playback by lifting your foot from the pedal and then press the pedal to
resume playback, the job will be automatically rewound 1 second before playback begins.

To change the backup amount, adjust the number shown next to the Auto backspace.
Adjustments are made in quarter second increments (0 = off and 20 = 5 seconds).

Ffwd Time determines how many seconds the playback position will be advanced each time the
fast forward button or pedal is pressed. When the fast forward foot pedal is held down the fast
forward command is issued continuously until the pedal is released. The amount of time between
successive fast forwards is determined by the fast forward delay setting (specified in milliseconds).
The larger the delay, the slower the playback position will move forward. Press the More...
button to change the fast forward delay.

Rew Time determines how many seconds the playback position will be moved back each time the
rewind button or pedal is pressed. When the rewind foot pedal is held down the rewind command
is issued continuously until the pedal is released. The amount of time between successive rewinds
is determined by the rewind delay setting (specified in milliseconds). The larger the delay, the
slower the playback position will rewind. Press the More... button to change the rewind delay.

Setup = Preferences * Advanced Playback Controls E|

FFwd delay [ms]: |250

Fiew delay [me]: (250

Playback Delay (=) |3 ﬂ

Def Play Speed: |E ﬂ Marmal

Speed Tupe: |E O=pitch-irvaniant 1=non pitch-irariant

Def D55 Type: & Olympus/Grundig © Philips

k. | Cancel

Trim Audio Peaks is a feature that, when enabled, tells Player to adjust audio data before it is
played such that very high (loud) values are truncated. On some computers peaks in the audio
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have caused the computer to reboot unexpectedly. In most cases this feature can be either enabled
or disabled with no noticeable difference to playback.

Playback Delay determines how long Player will wait after initiating the download of an audio
file before it will automatically begin playing the audio. This setting only affects automatic
playback which occurs when a file is highlighted and play is pressed. This is referred to as audio
previe because it does not affect the status of the job. The slower the connection to the Job Server
and the larger the audio files the larger the delay should be.

Def Playback Speed allows you to change the playback speed that Player initializes itself to when
the Player is started. Press the Normal button to return the default playback speed to normal
speed.

Speed Type allows you to turn on or off pitch invariant speed control. Pitch-invariant speed
control makes voice audio sound more natural when it is played slower or faster than normal.
Normally, the preferred speed type is pitch-invariant.

Def DSS Type tells Player what type of DSS files are used in your system. Player uses this
information to propetly display markers/bookmarks and to allow proper positioning during
playback. For Olympus and Grundig DSS audio files choose Oly/Grundig and for Philips DSS
audio files choose Philips.

Footpedal Selection

The Footpedal Selection group allows you to specify whether or not a footpedal is attached to
your computer and select the footpedal from the list of supported footpedals. If you specify that a
footpedal is attached and the Player cannot detect the specified footpedal when the Player is
started an error message will inform you.

Choose “Virtual Footpedal” when Player is being used with the optional speech recognition
Corrector or in a Citrix/remote Desktop environment. The Dataworxs Footpedal Service is
required.

When using a Philips European footpedal model (LFH6212/2310) in North America, enable the
“switch pedals” option to have Player internally modify the pedal mapping.

Philips Model Switch Pedals Checked | Switch Pedals Unchecked
LFH 6212/2310 rew/fwd/play fwd/play/rew
LFH 2320/2330 fwd/play/rew play/rew/fwd
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Using an Olympus Footpedal

To use an Olympus footpedal with Audioworxs Player you must first run the Olympus Foot
Switch Setup. The setup is called FSdist.exe and is installed by the Player setup.

Installed Location: iustall_dir\Dataworss Systems\Utilities \FSdist.exe
Shortcut: Start > Programs = Dataworxs Systems = Utilities 2 Olympus Footpedal Setup

Using an Olympus footpedal also requires that you press the Configure button to select the
correct footpedal type, USB or RS-232C (serial). If you selected serial choose the correct COM
port to which you have attached the footpedal.

Author Review

The Show Review Required jobs only option applies when logged into Player for Author
review. When enabled, Player will only display matching jobs that have the status REVIEW
REQD. When not enabled an author will also be able to see jobs that have the status
COMPLETE.

Screen Controls

Show Search Dialog on startup (Admin only) tells Player to automatically display the search
dialog as soon as the Player is started. Normally (and when this option is not selected) Player will
search for and fill the job list with jobs that match the search criteria selected the last time Player
was run. This option does not have an affect when you log in as a transcriptionist or author.

To prevent accidentally choosing search criteria that would result in thousands of jobs being read
from the Audioworxs database and unnecessarily tying up the system for a long period of time you
can tell Player to “Show a maximum of XXX jobs in the job list.” By default XXX is set to
2000. With the default, if your search criteria were to result in 10000 matching jobs only the first
2000 would be displayed in the job list.

Press More... to access additional screen controls.
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Setup = Preferences = Advanced Screen Controls

[ itwuta refresh screen eveny |5|:| j seconds
[ Manual refresh only

[ Dizplay Query Tagmark indicator in grid

[ Auto update

[ Change to Mini Window onJob selection

[v Enable Input Field substitution

Time dizplay format: & Rhmmese O mmmgss

Auto lagout after |222':I _%I zeconds of inachivity

k. | Cancel

Auto Refresh Screen refreshes the display at the selected intervals. With or without this feature

enabled the display screen is automatically refreshed every time an action is performed within the
program, such as selecting, returning or completing a job. The auto refresh option overrides this

feature and refreshes the screen at the defined time interval selected.

This option is ideal when the Player will not be accessed for an extended period of time and you
need to see new files appear in the display without performing an action.

Each time the display is refreshed the position of files previously displayed may be repositioned to
accommodate any new files that may have been added to the list.

The auto refresh feature is disabled when a Job is currently selected (i.e. active).

Manual refresh only disables the automatic refresh that normally occurs after a job is completed
or returned.

Selecting Display Query Tagmark Indicator in grid turns on a feature that displays a blue “tag”

attached to the priority indicator ball (a) when the job has a query tag associated with it. Usually
this feature would only be turned on when the Player is being used for editing purposes. (Note:
Turning this feature on can increase the time it takes to refresh the job list by 2-3 times.)

Auto Update is a feature that allows job information in the job list to be automatically updated on
a periodic basis. The auto update feature checks for changed job information every 5 seconds.
Information such as the status, priority and input field values will automatically be updated
periodically when enabled. Noze: This feature requires that the Audioworxs Client Monitor be
running on the same computer as Player.

Change to Mini Window on Job Selection tells Player to automatically select the mini window
view whenever a job is selected. When not enabled the mini window view can be selected manually
by clicking on the appropriate tool bar icon.
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Enable Input Field Substitution tells Player to change numeric values in the input fields with
“short names” defined in the Audioworxs system. For example, a value of “22” in input field 1
may be defined as the work type “H&P”. If this feature is enabled and the appropriate short name
has been assigned in the Audioworxs system, the value “H&P” will be displayed in the job list
wherever a value of 22 in input field 1 is found. If no short name has been assigned to a value the
original value will be displayed. Noze: This feature requires that Player is connecting to an
Audioworxs system that is running Audioworxs Job Server version 2.10.002 or greater.

The default display of audio length is in the format hh:mm:ss (hours:minutes:seconds).
Optionally, you can select the audio length display of mmm:ss (minutes:seconds).

The Auto Logout feature is a security feature that causes Player to automatically logout after the
specified number of seconds of inactivity. Inactivity is when no refresh, job selection, or playback
has taken place.

Manage Input Fields

Selecting Manage Input Fields in the Screen Controls group allows you to (a) assign custom
labels to the 10 input field columns, and (b) enable input field checking to assist in ensuring that
job demographics are as accurate as possible before completing the job. When enabled on one or
more input fields, Player’s input field checker can make sure that a value is numeric or
alphanumeric and make sure the value’s length is a specific length.

Manage Input Fields... le

Colurnn Labels Enable Checker j Allowed Characters Must Be Length

Input Field 0: [w/T v ldpharumeic  w| = +| |3 ]
Input Field 1: [MAM - | ~ = | =l
Iput Figld 2 W v rumericonly  w| 2= | |4 +]
Input Field 3: [FileName - | = =T =l
Input Field 4: [Unknown 4~ | = = T =l
Input Field &: [Input Field 5 r | = = [ =
Imput Figld & W - | = = [ =
Input Field 7: [Input Field 7~ [~ | = =T =l
Input Field & [MatterNbr [ apharumeic ~| = =] [ =]
Input Field & [F/CID v rumericonly  w| o= | |4 +]

Fefrezh Labelz From Job Server |

1] | Cancel |

When a job is completed, the input field checker will ensure that demographic values meet the
rules provided. If one or more fields fall outside of the specified rule, a message is displayed and
the job is not completed.
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Press the Refresh Input Field Labels when you want Player to re-read the 10 input field column
labels from the Audioworxs server. To save time when starting up, Player uses input field labels
that it has stored on the local computer. If the values are not stored locally (as in the case of a new
installation) or when the Refresh Input Field Labels button is pressed, Player gets the current
input field labels from the Audioworxs server. This option need only be selected if you know that
the input fields may have been re-labeled.

File Controls

By checking the option Upload transcribed document on completed job you will be prompted
to browse to the transcript document whenever a job is completed. The specified transcript
document is automatically sent to the Audioworxs system and the transcript becomes associated
with the job.

Use Document Templates enables automatic launching of prepared document templates based
on the selected job’s input field values. (Refer to the Audioworscs Administrator Guide - section Input
Values in the Audioworxs System Administrator chapter for a description of how to assign a
document template to a specific input value.)

Enable Find associated documents to have Player determine if an associated transcript
document exists when a job is selected. If an associated document exists it will be downloaded to
your local computer. When enabled, the Enable auto launch of associated documents feature
causes Player to launch the document associated with the selected job. The document is launched
using the local application associated with the document’s extension (for example, Word is
generally associated with a .doc extension). If Windows does not have an application associated
with the document’s extension the document cannot be launched. File associations can be created,
changed, or deleted using the Tools=>Folder Options menu item in Windows Explorer.

If Find associated documents is enabled and Enable auto launch of associated documents is
not enabled, a document associated with a selected job is downloaded to the local computer but
not launched.

The Local copy option is applicable when running Player on the same computer or Local Area
Network (LAN). It tells Player to access the audio and associated document files directly, by-
passing the Audioworxs File Transfer Server. Doing so greatly increases the speed at which
temporary copies of the files are made on your local computer. (Note: Bypassing the File Transfer
Server to transfer files also bypasses the encryption that File Transfer Server provides.)

When enabled, the Always use existing audio feature tells Player to use the matching temporary
audio file found in the Local Audio Folder if it exists rather than re-download a new copy. When
not enabled and an existing local audio file is found you will be prompted to choose between using
the existing file and downloading a new copy.

The Self-assign job when audio downloaded feature is used when a transcriptionist or an editor
wants to reserve (or self-assign) more than one job at a time. When enabled, after downloading
audio for one or more selected jobs the status of the downloaded jobs will be changed to
SUSPENDED. No other transcriptionist or editor will have access to these jobs.
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To provide a transcriptionist with the ability to preview (listen to) audio without actually selecting
the job the option Enable preview mode must be enabled. When enabled audio associated with a
job can be downloaded and listened to by single clicking a job in the job list and then pressing the
play button or pressing the play pedal. Caution: When this option is enabled a transcriptionist can
accidentally fully transcribe a job without having selected the job. When a job is not selected it
remains in the transcription pool and may be selected by another transcriptionist.

Choosing Enable background batch downloads allows for multiple jobs to be highlighted and
then downloaded independently of other operations. While audio is being downloaded in the
background another job may be selected and transcribed without having to wait for the download
to complete.

Pres More... to access additional file features.

Setup = Preferences = Advanced File Features E

Local Sign-Out

Local Sign-Out Folder:
|E:'xF'rngram FileshD atawarss SystemzAudioworss\ClhenthSignedOut J

[ Allows Editor] to override complete status

[ Allow Tran to overide complete status

v word document template field substitution

] | Caricel

Local Sign-Out specifies where on the local computer audio is transferred when jobs are “signed-

2

out’.

In order to provide a 1%-stage editor with the option of overriding their complete status, check the
option Allow Editor] to override complete status. When logged in as an Editor] and this
option is enabled the editor will received a message asking if they would like to override the
normal complete status and instead send the job to a 2™"-stage editor (i.e. set the new status to
“Edit2 Ready”).

Does job require additional editing? ﬂ

Py mormally your completed jobs are marked as complete,
\\/ Do ol wank Job 001-01-000002 ko go ko & 2nd stage editor instead?

1w |

If the editor’s normal complete status is “Edit2 Ready” then no message will be displayed.
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Similarly, in order to provide a transcriptionist with the option of overriding their complete status,
check the option Allow Tran to override complete status. When logged in as a Transcriptionist
and this option is enabled the transcriptionist will received a message asking if they would like to
override the normal complete status and instead send the job to a 1% or 2™-stage editor.

Enabling Word document template field substitution instructs Player to substitute coded tags
in a document template with job related values when a template is downloaded after a job is
selected. Details of supported tags are provided in chapter 3 of the “Audioworxs Administrative
Guide”. Microsoft Word must be installed if this option is enabled.

Document # 1.00.003.20110823 30 ©2004-2011 Dataworxs Systems Limited




Interface Options

()

Setup Options

PI’E:fE:rE:nCESI Folders  Interface Options ] Caonnection/Lagin SEtup] Third Party Interface SEtupl

Azzignment Matification Fieparter Interface [Admin Only)

Rpt Hb b]
v L document AL R

[ Commna delimited file Author Report: |2 j‘ |1

Estension; |TRMN Tran Report; |'| j |1

Editar 1 Repart: |3 j |1

Iv Include Group Mumber with User 1D

[ Create assignment notification at server £l ZlRizs e |4 = |1

Lol L d Ll f Lok el

o |
Iv Create onJob Campletion [only) Backlog Report: |-| z = |-I

Job InformationT ransfer

v “white Job |nfo to Clipboard
10 %2/ ED3%Ds

Job Info b agk:

Sample mask: Job MNbr: 2% T: Z0EBUthor ZMEIDate: Zdv'2dm2dd%IS ave Date: 2D3%0s

Mini Window b ask; |'W'T=Z|:I MRAM=31 --» ZD3%Ds

Doz Mame Mazk: [%)_%0 %1_%d5 doc

] | Cancel

Assignment Notification

See the document titled “Audioworxs Administrative Guide” (document #1.00.002) for more
detailed information about Assignment Notifications.

XML document or Comma delimited file defines the type of information exchange format that
is to be used for integration with a third party typing or workflow management system. If
Audioworxs Player is not being used with an integrated application do not select either option.

If XML document is selected an XML document named xxx-yyyy.xml, where xxx-yyyy is the
current login ID, is created in the folder specified by the Inter Process Control Folder specified in
the Folders tab.

If Comma delimited file is selected a file named xxx-yyyy.eee, where xxx-yyyy is the current login
ID and eee is the 3-character extension specified in the field labelled Extension, is created that
contains information about the selected job in a comma-delimited format.
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The option Create assignment notification at server, when checked, causes the selected
notification file or files to also be created by the Audioworxs Job Server in the server’s IPC folder.
The file(s) created at the server will have the same name and contents as those described for local
assignment notification files.

By default, the assignment notification file(s) are created as soon as a job is selected. To instead
create the assignment notification file(s) when the job is completed, enable Create on Job
Completion.

Job Information Transfer

When Write Job Info to Clipboard is enabled job information (as defined by the Job Info Mask)
is written to the clipboard every time a new job is selected for transcription.

The Job Info Mask is a string of characters and special expansion codes that represent various
pieces of information about a job. The Player recognizes the expansion codes and substitutes them
with the appropriate job information before writing the string to the clipboard. Characters that are

not recognized as expansion codes are written to the clipboard as they appear in the Job Info
Mask.

Once the information is copied to the clipboard by Player it can be pasted into any other Windows
program. For example, by switching to your typing program and pressing Ctrl-V the Job
information that you defined in the Job Info Mask will be copied into your text document at the
current cursor location.

All expansion codes begin with a percent sign (%) and are followed by one or more characters.
The following expansion codes can be used in the Job Info Mask.

%% Percent Sign (%)

%ol New Line (CR-LF)

%] Job Number (001-01-123456)
%1 Group Number (001)

%02 Section Number (01)

%0j3 Job ID (123450)

%0..%9 | Input Field 0..9
Y%A Author Number (001-1234)

%oa Author ID (1234)

%N Author Name (Smith, John)

%T Transcriptionist Number (001-1233)
Yot Transcriptionist ID (1233)

%E1 Editor 1 Number (001-1233)
%E2 Editor 2 Number (001-1233)
%op Job Priority (numeric value 0..100)
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%D0 Set date display mode (yyyy-mm-dd hh:mm:ss)
%D1 Set date display mode (yy-mm-dd hh:mm:ss)
%D2 Set date display mode (yyyy/mm/dd hh:mm:ss)
%D3 Set date display mode (yy/mm/dd hh:mm:ss)
%D4 Set date display mode (mm/dd/yyyy hh:mm:ss)
%D5 Set date display mode (mm-dd-yyyy hh:mm:ss)
%D6 Set date display mode (mm/dd/yy hh:mm:ss)
%D7 Set date display mode (mm-dd-yy hh:mm:ss)
%D8 Set date display mode (dd-mm-yyyy hh:mm:ss)
%D9 Set date display mode (dd-mm-yy hh:mm:ss)
%Dc Job Create Date

%Da Audio Create Date

%Ds Job Save Date

%Dt Tran Start Date

%DT Tran Stop Date

%d1 current system date (yyyy-mm-dd)
%d2 current system date (mm-dd-yyyy)
%d3 current system date (dd-mm-yyyy)

%d4 current system time (hh:mm)

%d5 current system time (hh-mm) — filename safe
%dY current system year (yyyy)

%dy current system year (yy)

%dm current system month (mm)

%dd current system day (dd)
%dH current system hour (hh)
%dM current system min (mm)
%dS current system seconds (ss)

For example, if the Job Info Mask is defined to be “Job: %J%lAuthor: %N%IWork Type: %0
the result of pasting the clipboard contents after selecting a job would look something like the
following:

Job: 001-01-123456
Author: Smith, John
Work Type: 22

Using the same mask expansion codes you can control what job information is shown on the Mini
Window’s title bar and also how an associated document template is renamed once it is
downloaded to the local computer.

Reporter Interface
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This section is used to map specific report numbers (as defined in Reporter) to the report options
available to administrators logged into Player. Report options are provided in the right-click menu
from the job list while logged into Player as an Administrator.

Since the first 10 reports in Reporter are completely configurable you must make sure that the
proper report number (Rpt Nbr) is mapped to the appropriate report option. The Backup Log
report option is normally mapped to report number 12.

The number of days that you specify determines the date range for which jobs will be included in
the report. The date range used will end on the current day and start with the date that is the
specified number of days before the current date. To setup the report to only show jobs from the
current day set the number of days to 1.
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Connection/Login Setup

Setup Options ll

Fuldersl F'referencesl Interface Options ~ Connection/Login Setup |

& Seript 0 ™ Sciipt 1 ™ Seript 2 ™ Seript 3 Apply |

—dJob Server

Script Alias:

IF':I 2r. 0 .0 01 ITranscriptiDﬂ
Port: I'IT-"DB

r— File Transfer Server

Station [D:
IMar_I.J1

|P;|12?- o .0 .1

Syztem Mumber:
: |1 7oz
Part: o0
— Login as...
User: IEIEI'I 1234

& Transcriptionist € Editor 1  Editwr 2 € aAuthor Review

— Connection Speed [File Transfer Buffer Size)

¥ =
* Cable/DSLAAN [32KB) Communications Timeout: IZU Ill
= 15DM [16 KE)

= Modem [2 KE]

" Custom buffer size I bytes

Ok I Carcel |

Up to four separate login scripts are maintained in this setup tab. Each script defines all the
information Player needs to connect to the host Audioworxs system. After selecting a script and
making your changes remember to press the Apply button to change the changes (for the selected
script only). If you press OK to leave the setup window script changes made without pressing the
Apply button will be lost.

A Script Alias is a short name that you can assign to a script to make it easier to remember what
the script is for. For example, a script to login as a transcriptionist might be assigned the alias
“Transcription” and an appropriate name for an Editor login script might be “Editor”.

In the Connection/Login Setup you configure IP addresses and port numbers necessary for the
Player to connect to the host system’s Job Server and File Transfer Server. The Station ID
identifies you on the host system and is used by the Audioworxs system to track where certain
events originated. Your name would make a good Station ID. The System Number is a number
that will be assigned to you by the Audioworxs system administrator. In most cases the system
number should be “0001”.

Select a Connection Speed than most closely matches your method of connecting to the host
system. The connection speed selected determines the size of data buffers that the application will
use to communicate with the host servers and can affect the speed at which audio files are
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transferred. For all types of Internet connections, start by selecting Cable/DSL/LAN. Doing so
will allow the fastest audio file transfers. If you notice problems when downloading audio try
decreasing the connection speed setting one level at a time until the problem stops. Audioworxs
Player must be stopped and restarted for a change to take effect. If you choose to put a value in
the Custom Buffer Size you are limited to values between 4096 (4 KB) and 65536 (64 KB). If the
Local Copy option is enabled in the Preferences tab the Connection Speed setting has no
effect.

The Communications Timeout value tells the system how many seconds to wait for a response
from the Audioworxs server before giving up and displaying a “timeout error (-6)”” message. On
particulatly busy systems increasing this value may reduce the number of timeout errors received.

Third Party Interface Setup

X)

Setup Options

Preferences] Fl:nlders] Interface Dptians] Cornection/Login Setup  Third Party Interface Setup l

ELpedium Yaoice Recognition Interface

Destination Falder: |E:'\ELpedium"-."S \SpeechDatalutT rans Browsze...

['Where voice recognition file collection: are expanded.)

Launch Application: |E:'\F’mgram Files\E Lpedium''S \WwWiomector exe Browse...

[Launch this application after a voice recognition file collection iz downloaded. )

MPword Interlface

[ Enabled Demographics Mapping...

eCDocz/Legall ocs Interface

| Enabled

(] | Cancel
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Audioworxs Player has been designed to interface with third party products that add additional
functionality. ELPedium (formerly XoVox) provides voice recognition services, MPWord provides a
typing environment for improved document tracking, and eCDocs (LLegalDocs in some areas) provides
typing and document management functions.

ELPedium Voice Recognition Interface

ELPedium integration requires that ELLPedium integration and Dragon Naturally Speaking is installed
on the Audioworxs server or on a computer connected to the Audioworxs server.

When Enabled you must specify a Destination Folder. This is the folder where files from a voice
recognition (VR) file collection (iff file) are expanded to. A VR file collection is a single file that
contains multiple files -- in much the same way as a ZIP file. It contains files required by the ELLPedium
application to provide playback and correction services. The default is
“c:\ELPediumVS\SpeechDataOutTrans”. The Launch Application is the ELPedium application that
will automatically be launched by Player when a job containing a VR file collection is selected. Normally
the “Launch Application” will be “c:\Program Files\ELPediumVS\WCorrector.exe”.

When the “Launch Application” is launched (i.e. executed) the footpedal support for Player will
automatically be disabled. To re-enable footpedal support once the transctiption/editing using the
launch application is finished, check the checkbox labeled “FP” on the main job list window.

v FF

MPWord Intetface

MPWord is transcription software specifically designed for the medical transcriptionist. It provides a
typing environment based on Microsoft Word that lets you select patient and dictator information from
lists, automatically applies formatting rules based on facility, automatically calculates line counts and
offers unlimited abbreviation expansion.

When integrated with Audioworxs Player is turned on by checking Enabled, a typed transcript that is
associated with an Audioworxs job when it is completed is scanned for demographics information
added by MPWord and mapped to one or more of the 10 input fields supported by Audioworxs. Click
on Demographics Mapping to map MPWord demographics to Audioworxs input fields. Each drop-
down list contains the MPWord demographic currently supported by Audioworxs Player.
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MPWord Mapping 5'

Input Figld 0 |<Empty> | InputField & |Date of Admission

Input Field 1:

j Input Field E: |Date of Dizcharge

j

< E mphy> |

Input Field 2: <Emply> = Input Field 7: IDate af Birth j
=~

=l

Patient Mame [Last, First]
Patient Mame [Last, First Mid

Input Field 3: Patient Name (Last] Input Field &: IMHN
Input Field 4: || atient Name [Firt] Input Field 9 |Patient Name [Last, First]
Date of Birth i
Date of Admizzion ;I
QK _I Cancel |

Warning: Only map an MPWord demographic to an input field that is not currently being used for
other demographics. If you do by accident, the existing value will be replaced with the new value from
the MPWord document.

eCDocs/LegalDocs Interface

When checked, eCDocs (in North America, LegalDocs in the U.K.) support is enabled. When enabled,
two changes to Player’s workflow occur:

1) You will not be prompted to choose an associated document when a job is selected. The system
assumes that the last associated document is the correct one and automatically selects and

downloads it.

2)  When Player is signaled to complete the cutrent job by the ELPedium corrector, the edited Word
document is automatically associated with the job. A copy of the Word document is not made.

Normally, the eCDocs interface requires that the ELLPedium interface also be enabled.
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GLOSSARY

Job Number

Audioworxs assigns each job a unique number in order to keep track of it, much as you assign
every user a unique user ID. The job number is comprised of the author’s 3-digit group number
followed by the author’s 2-digit section number, followed by a 6-digit number.

Status

Different statuses can be assigned to a job by the author who recorded it, or by a supervisor with
the System Manager Change command. Jobs with the following statuses may be visible in Player as
a Transcriptionist:

e Transcription — The job is ready to be transcribed and is part of the general pool. Other
transcriptionists may be able to see the same job.

e Tran Assigned — The job has been specifically assigned to you. Only you will see the job in
your Playet’s job list.

e Tran Active - The job has been selected for transcription and is now assigned to you. Under
some conditions more than one job may have the status “Tran Active” but you will only ever
have one job selected at any one time (as identified on the main window beside the label
“Selected Job”).

e Tran Suspended — The job has been suspended. No other transcriptionist will be able to see
your suspended jobs.

Jobs with the following statuses may be visible in Player as an Editor:

e Tran Query — The job was completed by a transcriptionist after having added a query tag
indicating that there was a problem area. All 1" stage editors will see these jobs in the job list.

e 1" Edit/2" Edit — The job is ready for editing. Other editors may be able to see the same job
in their job list.

e Edit 1/2 Assigned — The job has been specifically assigned to you. Only you will see the job
in your Player’s list (when logged in as an editor).

e Edit1/2 Active — The job has been selected for editing and is now assigned to you.

e Edit 1/2 Suspended — The job has been suspended. No other editor will be able to see your
suspended jobs.

Priority

Each job — regardless of its status — is assigned a priority from 0 to 100. The priority assigned to a
job determines its relative importance and affects how and when a job is routed. A job that has a
priority value that is higher than another job of the same status is considered to have a higher
priority. A priority of 0 is considered Blocked — that is, the job will not be issued to any
transcriptionist.
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Author Number

The Author column shows the name or number of the author who created a given dictation. An
Author Number is a combination of a group number and the author’s specific ID. For example,
author 1234 belonging to group 002 will have an author number of “002-1234".

Audio Length
The length is the duration of the audio associated with the job (expressed in hours, minutes and
seconds - hh:mm:ss).

Input Field 0to 9

The input field columns show input values entered by an author or assigned to the job
automatically. The specific meaning of each of these input fields will vary depending on your
organization. For example, input field 0 may be defined as “Work Type” in your organization but
defined as “MRN” in another. Player automatically reads input field labels that are used as the
input field column headings from the Audioworxs server when Player is first started. You can tell
Player to re-read the input field labels using the appropriate selection in the Preferences tab in the
setup dialog.

Save Date
The save date is the calendar date on which the dictation author finished the job and saved it.

Audio Create Date

The audio create date is the calendar date on which the audio associated with a job record was
created. It may or may not be the same as the create date. In the case of audio files that are
created from outside sources being imported into the Audioworxs system, the audio create date
may be before the Job’s create date.
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